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Even with new versions of Excel, many hints and tips continue to provide great value to Excel users.  
Now, combine that with the new features of Excel, and you have a powerful list of 15 top hints and tips.  
This session will cover all 15 top hints and tips.  You may know some, but you will not know all of these 
helpful techniques.  
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Tip #1 - Display of Zeros and Precision as Displayed 
One of the confounding problems of using any of the financial number formats (accounting, currency, 
and number) is the display of zeros. Recall that the third part of any number format code is the code to 
display zeros. However, the format code only applies when the value in a cell is equal to zero, not when 
the value in a cell appears to be zero, such as when a small value rounds off automatically to zero for 
display. This is especially problematic when using the accounting format because cells can be displayed 
as zeros, positive zeros, or negative zeros as shown in Figure 1. 

 

 

Figure 1 - Zero Display Using the Accounting Format 

Some practitioners have become so frustrated with this problem that they enter hard-coded zeros over 
formulas when this occurs so that zeros display consistently throughout their reports. In the process of 
overwriting their formulas, however, they potentially corrupt their worksheet so that it does not 
recalculate properly in the future. 

There are two easily applied solutions to this problem. The most common solution is to round-off 
calculations to the number of displayed decimals. In other words, the values 0.001 or -0.001 (or smaller) 
rounded to two decimals would result in a cell value of zero, which would be displayed properly when 
using the accounting format. When a positive or negative zero cell is encountered, simply round the 
contents of the cell to the appropriate number of decimal places using the ROUND function. 

The second solution to this problem is to enable global rounding in the affected workbook. When global 
rounding is enabled, all values are rounded to their cell formats. In other words, the values 0.001 or  
-0.001 (or smaller) displayed with two decimals would automatically be rounded to a cell value of zero, 
which would be displayed properly when using the accounting format. To enable global rounding in a 
workbook, users of Excel 2010 should click the File tab of the Ribbon, Options, Advanced, and, in the 
section labeled When calculating this workbook, check the box next to Set precision as displayed and 
click OK. 

Excel 2007 users should click the Office Button and then Excel Options. Select Advanced on the 
Navigation Bar on the left. In the Option Pane on the right, check Set precision as displayed in the 
section entitled When calculating this workbook. Click OK.  

Regardless of which version of Excel is running, enabling global rounding in a workbook causes Excel to 
display the warning shown in Figure 2. 
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Figure 2 - Warning Message Displayed When 
Precision as Displayed is Enabled 

Do not be alarmed by the warning. Click OK, and all of the cells that contain zeros will now display 
properly. 

Before continuing, an explanation of the warning message is in order. To do that, we must first review 
how Excel makes calculations. In default, Excel rounds off for display but uses the underlying data to 
make calculations. Precision as displayed alters the way that Excel evaluates formulas. With precision as 
displayed enabled, Excel ignores the underlying data and uses the data displayed on the screen to make 
calculations. Hence, when precision as displayed is enabled, all calculations will foot and cross-foot 
properly. In other words, practitioners will not encounter the proverbial one-cent rounding error that 
often results in worksheets because the numbers displayed on the screen are used to make the 
calculations. The example in Figure 3 will help in explaining precision as displayed.  

 

Figure 3 - Rounding Error Corrected by Enabling Precision as Displayed 

Note the one-cent (least significant digit) rounding error in the table at the top of Figure 3. The total 
displayed is $297.71 but should read $297.72. The error occurs because Excel is using the underlying 
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data shown in the column displayed on the right to make the calculation. In the bottom table, precision 
as displayed has been enabled. In this case, Excel is using the data displayed on the face of the 
worksheet to make the calculation, and the rounding error disappears. 

Note that this issue does not arise when cells contain formulas. In other words, precision as displayed 
can be enabled or disabled at will without any impact on the accuracy of the underlying data when the 
data results from formulas. Since most, if not all, of our rounding issues result from floating point 
calculations, and since most practitioners are not likely to type in constants with more decimal places 
than are displayed, precision as displayed is not likely to pose a problem in day-to-day practice.  

Tip #2 - Excel 2003 vs. 2007 & 2010.  It’s All There Somewhere! 
All the commands and functionality of prior versions of Excel are still in Excel 2007 and 2010.  However, 
because people cannot find them in the Ribbon Interface, they believe they are gone.  That is not true.  
It is all there, somewhere, with the exception of the OLAP Cube Wizard.  It is also easier to find 
commands now with all commands listed in numeric, then alphabetical order. 

Learning Tool: 

 

The best version is the guide you can download and install on your desktop. 

Example: 
Text to Speech – Speak Cells. 

 

 

Tip #3 - Use AutoCorrect to Your Advantage 
AutoCorrect is a powerful, little-utilized tool that is a source of frustration for most users. Its 
functionality allows users to create shorthand Figure entries for commonly entered text. The frustration 
arises when users enter text in cells, and the text entered is the object of a default AutoCorrect entry. 
For example, the text "§123(c)(3)"is replaced with "§123©(3)".  Instead of living with these settings, 
change them to your liking and consider adding shortcuts for items that you use frequently.  You can use 
up to 255 characters in your shortcut paragraph. 
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Tip #4 - Understanding Excel Dates  

Gregorian Calendar 
Excel dates are actually serial numbers that follow the Gregorian calendar and have a start date basis of 
January 1, 1900.  To see this, change the format on the date to any numeric format or use General 
format, and you can easily see the number. 

 

1904 Date Basis 
Not all information systems followed this rule, and, as a result, some use the start date of January 1, 
1904.  For many years this was a non-issue, but the reemergence of Apple products makes this an issue 
again.  Excel can handle these issues with a setting found in Excel Options Advanced.  This is a workbook 
setting. 

 

 

Date and Time Stamps 
Users can add date or time stamps to any worksheet quickly using keyboard shortcuts as shown in 
Figure 4. 

 
Figure 4 - Add Date and Time Stamps Using Keyboard Shortcuts 
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Note that date and time stamps added using these techniques are “hard-coded” into the worksheet and 
do not update with the computer’s system clock. For a dynamic date stamp, enter =TODAY( ) in a cell; 
for a dynamic time stamp, enter =NOW( ) and change the format so that the cell only displays the time 
and excludes the date. 

Tip #5 - Select Visible Cells 
When copying cells, you can copy just what you see. This is not a new feature and has been available 
with some digging since Office 97.  To do this, you will need to highlight visible cells prior to using the 
copy command.  Now choose the Select Visible Cells command either with the special button on the Go 
To command or the special Select Visible Cells icon. 

 

Figure 5 - Select Visible Cells Icon 

Tip #6 - The Accounting Format and Custom Formats 

The Accounting Format 
When asked if they use the accounting format, many accounting professionals respond that they do not 
use it at all. In reality, the accounting format is probably the most frequently used number format within 
the profession. That is because the accounting format is applied whenever the currency or comma styles 
are selected from the Home tab of the Ribbon, as shown on the left in Figure 6, or from the Mini-
Toolbar, as shown in the same figure on the right. The Mini-Toolbar appears whenever a user right-clicks 
on the worksheet grid. 

 

Figure 6 - Currency and Comma Style Buttons on the Ribbon and Mini-Toolbar 

The currency style applies the accounting format with the dollar sign and two decimal places, while the 
comma style applies the accounting format without the dollar sign. The accounting format displays 
negative numbers within parentheses and ensures that decimal points align – perfect for financial 
reports! 
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Single and Double Underlines 
The accounting format affects the way single and double underlines are applied to numbers and labels. 
When using the accounting format, single and double underlines for subtotals, totals, and column 
headings do not span the entire column as do cell borders. The accounting format indents single and 
double underlines one character space from the left and right cell margins. This provides the necessary 
break in underlines across adjacent columns without resorting to the common practice of inserting 
narrow faux columns to accomplish the same effect.  

 

Figure 7 - Report Showing the Effect of the Accounting Format on Single and Double Underlines 

Figure 7 displays single and double underlines applied to labels and numbers in cells formatted with the 
accounting format. Notice how the single and double underlines do not quite span the width of the cells, 
thereby allowing for breaks in the underlines between adjacent columns. 

 

Figure 8 - Applying Underlines and Double Underlines from the Ribbon 

 For single and double underlines to display and print properly for cells 
containing text, the single or double underline formats must be applied 
after applying the accounting format.  For cells that are already underlined 
when the accounting format is applied, simply remove and then reapply the 
underline format. 
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Custom Formats 
Custom formats can format numbers and text in ways suitable for financial reporting.  For example, 
financial statements may need to be restated and reported in thousands, millions, or billions. While 
many accounting practitioners accomplish this task by dividing their actual data by an appropriate 
divisor, the same result can be accomplished by merely using a custom format to display the existing 
actual data in thousands, millions, or billions as shown in Figure 9. 

 

Figure 9 - Using Custom Formats to Report in Thousands or Millions 

To create a custom format to report in thousands, millions, or billions, first format your cells with the 
desired accounting formats – with or without decimals and dollar signs. Next, access the Format Cells 
dialog box with the dialog launcher in the Font group on the Home tab of the Ribbon or from the 
context-sensitive menu. In the Format Cells dialog box, select the Number tab and then Custom in the 
Category box. Modify the format code in the Type box to append commas to the positive and negative 
formats appropriate for your needs. To format the numbers in thousands, append one comma; for 
millions, append two commas; and for billions, append three commas. 
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 A format code consists of up to four parts separated by semicolons. 
Each part of the code formats a specific type of numeric or text data 
within a cell. 

 

Figure 10 contains the appropriate format codes for using the accounting format displayed in 
thousands, millions, and billions. Note the comma placement identified by the arrows and underlines. 
Also, note that the toolbar buttons for increasing or decreasing the number of decimal points displayed 
works with these custom format codes. 

 

Figure 10 - Custom Codes for Displaying the Accounting Format in 
Thousands, Millions, and Billions 

To display and print negative numbers in red, modify any number format to include the tag [Red] 
immediately preceding the negative number format code as shown in Figure 11. In addition to red, the 
following colors may be used in format codes: black, white, green, blue, magenta, yellow, and cyan.  

 
Figure 11 - Format Code to Display and Print Negative Numbers in Red 
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Some accounting professionals prefer to display 0.00 for zeros when using the accounting format. This is 
accomplished easily by modifying the accounting format to include the appropriate zero format code. 
The two custom format codes required, one with dollar signs and the other without, are displayed in 
Figure 12. 

 

Figure 12 - Accounting Format Code Modified to Display 0.00 

Custom Date Formats 
Just like number formats, date formats can be customized. The following table contains the codes for 
building custom date formats. 

To Display Use Code 
Months as 1-12 M 
Months as 01-12 Mm 
Months as Jan-Dec Mmm 
Months as January-December Mmmm 
Months as the first letter of the month mmmmm  
Days as 1-31 d  
Days as 01-31 dd  
Days as Sun-Sat ddd  
Days as Sunday-Saturday dddd  
Years as 00-99 yy  
Years as 1900-9999 yyyy  

Table 1 - Custom Date Format Codes 

In the worksheet shown in Figure 13, the column headings are entered as dates. In this case, each 
column heading is the last date of the month formatted to display the three-letter abbreviation for the 
month. 

 

Figure 13 - Using Date Formats to Display Month Headings 
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Using dates as column headings allows the report date in the report heading to link easily by formula to 
the latest reported month. This insures that the report date is always accurate and does not require 
manual update. 

Tip #7 - Cleanup Data with Text to Columns Command 
The data parsing capabilities of Excel are excellent, but you can often still end up with junk in cells.  
When faced with text that looks like numbers or dates that will not work, run the Text to Columns 
command, use the delimited option, but select no delimiter.  This will run the data through the standard 
“car wash” and should clean up your issues. 

Tip #8 - Data Validation Setting 
You can control what users place in each cell.  You can even customize an input message and an error 
message.  Each cell can have a valid range or value. 

 

Figure 14 – Using Data Validation to Control User Input 

Tip #9 - Applying Page Settings to Multiple Worksheets 
One of the most frequently questions asked of K2 instructors is how to apply page settings to multiple 
worksheets at the same time. To apply page settings such as headers and footers to multiple worksheets 
simultaneously, group or activate the appropriate sheets and then set the appropriate page settings. To 
group multiple sheets, hold the CTRL key down while clicking the tabs of the worksheets to which you 
want to apply the same page settings. The tabs of grouped worksheets will be highlighted when selected 
as shown in Figure 15. 
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Figure 15 - Grouped Sheets Having Highlighted Tabs 

When worksheets are grouped, any page setting configured will apply to all sheets. In other words, to 
set headers and footers on multiple worksheets at one time, first group the sheets before entering the 
headers and footers. 

The page settings of an existing worksheet can be applied or transferred to other worksheets in the 
same workbook. However, the worksheet that contains the settings that you want to transfer must be 
selected first in the grouping process. Simply select the desired worksheets, making sure to select first 
the worksheet that contains the page settings to be transferred. Now, from the Ribbon, choose Page 
Layout, click the dialog launcher in the Page Setup group, and then click OK. It is as simple as that! The 
page settings on a worksheet in another workbook can be transferred similarly by first dragging a copy 
of the worksheet into the current workbook, going through the page setting transfer steps described, 
and then deleting the imported worksheet. Note that all print settings are transferred by this method. 

Tip #10 - Using the Camera to Create Report Forms 
Creating print areas causes them to print on separate pages in the order selected. Quite often, users 
would like the several print areas to print on the same page in a specific layout. In other words, their 
report is made up of multiple small snippets of a workbook arranged on a single page. We refer to the 
resulting printable sheet as a report form. Those faced with the task of building reports in this fashion 
understand the difficulty of achieving this result. Cutting and pasting doesn't work because the column 
widths of the individual snippets vary, so the report doesn't line up properly. Further, cutting and 
pasting results in static reports that require a repeat of the process when the underlying data changes. 
Building formulas to bring live data to a report print area is a better solution, but the process is time-
consuming and cumbersome, and there is no guarantee that the data will line up any better than with 
cutting and pasting.  

That brings us to the Camera tool. The Camera allows users to cut and paste dynamic pictures of data 
ranges which can then be arranged in any layout for display or printing. To use the Camera, first add the 
tool to the QAT. Just click on the drop-down arrow at the far right end of the QAT and select More 
Commands. In the Excel Options dialog box, select Commands Not in the Ribbon. Scroll down in the list 
of commands and select the Camera tool. Click Add and then OK to close the dialog box as shown in 
Figure 16. 
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Figure 16 - Adding the Camera to the QAT 

The use of the Camera is very similar in operation to cut and paste. Highlight the range to copy and click 
the Camera toolbar button. Now, navigate to the worksheet that will serve as your report form and click 
with your mouse on the sheet. A picture of your data snippet will be pasted on the worksheet. Click and 
drag the picture to its proper location. Repeat the process with other data snippets to build your report 
form as shown in Error! Reference source not found.. 

Tip #11 - Pasting Excel into Word for Reports 
The most common practice among accounting practitioners is to paste financial data from Excel into 
Word. Word provides better control of headers, footers, and pagination and generally provides for 
higher quality document printing. When pasting Excel into Word, a user can choose from several 
different paste commands in the Clipboard group on the Home tab of the Ribbon. 

• Paste Special, Microsoft Office Excel Worksheet Object – This creates an embedded Excel 
object in a Word document that can be edited in place within Word. The source layout and 
formatting remain intact. 

Each of the Paste Special commands can be pasted with or without a link to the original Excel 
worksheet. Links allow updates made to the source worksheet to flow through to the target document 
whenever the link is refreshed. 

Figure 17 shows the difference in results between Paste and Paste Special, Picture. Given the inherent 
problems of working with Word tables, pasting Excel data as a picture will give most users better results. 
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Figure 17 - Pasting a Picture vs. Pasting Formatted Text from Excel into Word 

Creating or pasting an Excel worksheet object in Word provides users with the ability to format the 
embedded or linked object in place. In other words, there is no need to open Excel to modify the object. 
Just double-click on an Excel object, and Word will transform itself into Excel and allow full editing and 
control of the worksheet. When the editing is complete, just click in the Word document outside of the 
Excel object, and the application will transform itself back into Word. Note that if you link or embed 
multiple-page Excel objects in Word, only the first page of the objects will print in Word. 

Tips for Pasting Excel into Word 
Here are some tips for getting improved results when pasting Excel data into Word or embedding or 
linking Excel objects into Word. 

• Under most circumstances, users will get better results by pasting a picture of an Excel range, 
such as a balance sheet, income statement, or cash flow statement, into Word rather than 
pasting the range as formatted text (the default). 

• If your report will not fit on a single page in Word, paste multiple page-sized pictures instead. 

• Paste links whenever flow-through reporting is desired. That way, as the data in the linked Excel 
worksheet is modified, the updated data will flow through to the Word document. Each time a 
Word document that contains a link to an Excel spreadsheet is opened, the user will be 
prompted to update the link. 

• Three- or four-line financial statement headings may be better controlled as page headers in 
Word. 
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• If you are pasting or linking single Excel cells within Word text, and if the source worksheet 
utilizes the Accounting Format, use simple formulas to link the cells to another worksheet within 
the source workbook. Change the number format in the new worksheet to Currency. Then, link 
the cells on the new worksheet to Word so that you have better control over text spacing.  

Tip #12 - Finding Formulas in a Workbook 
Simply issue an F5 or Go To command, select special, then highlight formulas.  Once you have all the 
formulas highlighted, you will want to touch some type of formatting such as the Highlighter tool so that 
you will know exactly which cells have formulas and which ones do not. 

 

Figure 18 – Finding Formulas in a Workbook 

 

Tip #13 - Footnotes on Numbers 
This tip is only for those of you who are obsessive, although that may include a majority of the 
accounting profession. From time to time, accounting practitioners ask whether it is possible to have 
footnote numbers on numeric data. It is possible, but the process is sufficiently convoluted to warrant 
its use only in the context of templates. In other words, we do not necessarily suggest using this process 
in workbooks created as part of day-to-day tasks and activities. 

Attempts to add footnote numbers to numeric data usually end in frustration. That's because the 
footnote number becomes the least significant digit in the number to be footnoted, and because the 
superscript formatting is not maintained. Since a footnote number actually alters the numeric value in a 
cell, any calculation on the number is also affected. The solution is to convert the numeric data to text. 
However, that creates another problem – we can't use labels that look like numbers in calculations using 
functions, such as SUM or AVERAGE, that accounting professionals use every day. The solution requires 
numeric data that is calculated accordingly on one worksheet (the working sheet) and reported on 
another (the reporting sheet) as text that looks like numeric data, along with the requisite footnote 
numbers. The footnote numbers will be added to the reporting sheet by using a VLOOKUP table. The 
lookup table will consist of numbers cross-referenced to UNICODE superscript numeric characters. 
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The Footnotes on Numbers.xlsx file contains the sample data that we will use for this example. It 
contains three worksheets: 1) Numeric Balance Sheet, 2) VLookup Table, and 3) Report Balance Sheet. 
Figure 19 shows the Numeric Balance Sheet. The amount columns contain numeric data. The narrow 
green columns contain the desired footnote number for the data. 

 

Figure 19 - Balance Sheet with Numeric Data 

To begin, format the VLookup Table and Report Balance Sheet with Lucida Sans Unicode font. On the 
VLookup Table worksheet, create the VLOOKUP table to return the superscript numbers associated with 
the footnotes desired as shown in Figure 20. 
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Figure 20 - VLOOKUP Table to Return Footnote Numbers 

To create a VLOOKUP table to handle up to fifteen footnotes, do the following. 

1. Create a list of numbers from 1 to 15 in column A. 

2. In column B, adjacent to each cell containing a number, enter the Unicode character(s) for the 
equivalent superscript digit(s). From the Insert tab of the Ribbon, select Symbol. Scroll through 
the list and select the appropriate character. Click Insert and then Close. 

3. Move down one cell and repeat the process until the list is complete. 

 
Note that a UNICODE character set must be used. Make sure to format the 
worksheet holding your VLookup table and final report in Lucida Sans Unicode.

 
4. Create a defined name for the table. Highlight the table and then type in Footnotes in the Range 

Box. 

With the VLOOKUP table created, we need to create a formula to move the data to the report 
worksheet, along with a footnote, if it exists. Our formula will need to use some of the trickery discussed 
earlier to get the result that we desire. Figure 21 shows the results of our efforts. 

Copyright © 2015, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited.
16



 

 

Figure 21 - Report Balance Sheet with Footnotes Displayed on Numbers 

Here is the generalized form of the formula used to move and concatenate the data. The sheet 
reference has been removed for clarity. 

1: =IF(B8="","", 

2: TEXT(B8,"_($*#,##0_);_($*(#,##0);_($*_???") 

3: &IF(ISERROR(VLOOKUP(C8,Footnotes,2))=TRUE,"", 

4: VLOOKUP(C8,Footnotes,2))) 

The first line tests whether there is data in a cell of the Numeric Trial Balance. If no data is found, the 
formula returns a null string so that the cell appears blank. If it finds data, the second line converts it to 
text formatted with a modified accounting format. Line three tests whether concatenating a nonexistent 
footnote causes an error. If it causes an error, the formula concatenates a null string. If it does not find 
an error, it concatenates the proper superscript character for the footnote from the VLOOKUP table. 

Copyright © 2015, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited.
17



 

Tip #14 - Copy an Entire Worksheet Quickly (all page, print, other 
settings) 
Most users learn how to right-click on a sheet tab and then use the Move or Copy command.  This is the 
second fastest way to accomplish a complete copy of a worksheet.   Instead, hold down the CTRL key, 
then left-click on the sheet tab, and drag and drop the sheet to a new spot which will create an exact 
copy in less than a second, as shown in Figure 22. 

 

Figure 22 – Copy an Entire Worksheet Quickly 

Tip #15 – Performing Fuzzy Lookups in Excel 
 Sometimes when using Excel’s VLOOKUP and HLOOKUP functions, we don’t get the results we are 
seeking, not because of anything we are doing wrong, but because the data we are trying to match 
together is not an exact match. For example, if you are trying to perform a VLOOKUP to find 123 Main 
Street, Excel will not match that to 123 Main St. Fortunately, for those who need to match inexact data, 
Microsoft offers the Fuzzy Lookup Add-in for Excel. In this tip, you will learn how to put this very 
powerful tool to work so that you can perform fuzzy lookups on your data. 

Download the Add-in 
Before you can use the Fuzzy Lookup Add-in for Excel, you must download it from Microsoft and install it 
on your computer. You can do this by visiting http://www.microsoft.com/en-
us/download/details.aspx?id=15011 and following the instructions provided by Microsoft. Note that as 
part of the download package, Microsoft also provides you with a sample data set you can use for 
practice; however, the example presented below uses a different data set. 

Creating a Fuzzy Lookup 
Keep in mind that that the Fuzzy Lookup Add-in matches inexact textual data and allows you to join data 
from multiple tables into one. Therefore, for your fuzzy lookup to work, you must first convert your data 
ranges to Excel tables.  

Figure 23 presents two tables we will use for the basis of our fuzzy lookup. SSN is the name of the table 
on the left and Comp is the name of the table on the right. We would like to match the Name field in 
SSN to the Name field in Comp and create a results list that shows employees’ names, Social Security 
numbers, and compensation. The challenge we face is that not all of the names are spelled and arranged 
the same way; therefore, if we attempt to use a VLOOKUP function to complete this task, we will not be 
successful. For example, consider the name Jan Kotas on row 4 of SSN. In looking at row 8 of Comp, we 
see that what should be the matching name is arranged as Kotas, Jan; thus, a VLOOKUP function would 
not match the two names together. Likewise, Robert Zare on row 8 and Thomas Axen on row 13 of SSN 
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are not exact matches to Robert Zare, III on row 11 and T G Axen on row 17 of Comp, again presenting 
problems if we try to match based on traditional methods. 

 

Figure 23 - Tables for Fuzzy Lookup 

However, we can match the data in these two tables using the Fuzzy Lookup Add-in. To do so, click Fuzzy 
Lookup on the Fuzzy Lookup tab of the Ribbon to open the Fuzzy Lookup task pane on the right side of 
the window shown in Figure 24. Upon doing so, Excel automatically senses and inserts the names of the 
tables into the Fuzzy Lookup task pane. Excel also automatically analyzes the columns in the tables and 
joins the tables if a column in one table has the same column header as a column in the other table. Of 
course, you can edit both the table and column selections, if necessary. 
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Figure 24 - Creating a Fuzzy Lookup in Excel 

In the Output Columns section, check the box next to each field you want included in your results list. In 
this example, we are indicating that we want the Name and SSN fields from the SSN table and the 
Compensation field from the Compensation table to be included in the output. We are also indicating 
that we want the system-generated Similarity score to be included. The Similarity score provides a 
measure of how “confident” Excel is in its matching of inexact data. With these processes complete, all 
that is left to do is click Go. Upon doing so, the Fuzzy Lookup Add-in analyzes the data in the two tables 
and provides the results list pictured in Figure 25.  

Copyright © 2015, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited.
20



 

 

Figure 25 - Sample Fuzzy Lookup Results 

A close inspection of the data in Figure 25 reveals that the tool worked well, though not flawlessly. In 
particular, it did not find matches for Mariya Sergienko and Thomas Axen. Returning to the Fuzzy 
Lookup task pane, let us modify the Similarity Threshold setting to see if reducing the confidence level 
slightly increases the number of matches. To do this, drag the Zoom Slider to the left so that a smaller 
value – in this case, 0.4 – is in place. 
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Figure 26 - Modifying the Similarity Threshold for a Fuzzy Lookup 

After modifying the Similarity Threshold, click Go to generate a new set of results. Upon doing so, as 
shown in Figure 27, the Fuzzy Lookup Add-in matches all of the data in the two tables and does so 
without any errors. 
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Figure 27 - Completed Fuzzy Lookup Example 

Summary 
When faced with the task of matching inexact data, including names and addresses, many Excel users 
expend vast amounts of time cleaning up the data before using traditional techniques such as VLOOKUP. 
With the Fuzzy Lookup Add-in for Excel, that need not be the case. By downloading and installing this 
free tool from Microsoft, we now have an extremely powerful and efficient means for matching data 
when perfect matches do not exist. 

For a video demonstration of this tip, please visit www.tinyurl.com/k2tips121. 
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